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About this book

This book provides descriptions of the reports available  in the Pyxis™ Enterprise 
Server and the Pyxis MedStation® ES station. For information on generating 
reports or using the Pyxis MedStation ES system, refer to the Pyxis Enterprise 
Server User Guide and the Pyxis MedStation ES User Guide.

For information about the Pyxis MedStation ES system not covered in this 
document, call the CareFusion Technical Support Center for Pyxis products (TSC) 
at 800.727.6102 or 858.617.2000.

Overview of this document
This document contains a separate chapter for each type of server and device 
report provided with the Pyxis Enterprise Server system or the Pyxis MedStation 
ES system. Within these chapters, reports are listed in alphabetical order. For each 
report, this document includes a description. The description identifies the 
purpose of the report, explains what it contains, and, if applicable, indicates how 
frequently to run the report.

NOTE
In some cases, the name of the report listed in the software interface does not 
match the name displayed in the final report. To accommodate this, headings 
identify the report based on the name used in the software, and the alternate 
name is listed immediately after the heading.
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About this book

 

This document includes the following information about the Pyxis Enterprise 
Server and Pyxis MedStation ES systems reports.

• Chapter 1, Introduction

• Chapter 2, Device reports. Device reports are designed to help your 
workflow.

• Chapter 3, Server: Activity reports. Activity reports include specific 
information on all accesses, charges and credits, loading and unloading, 
discrepancies in the system, and refill activities.

• Chapter 4, Server: Inventory reports. Inventory reports provide a detailed 
account of the status of inventory throughout the system, allowing effective 
inventory management.

• Chapter 5, Server: System reports. System reports provide you with a 
snapshot of what your system contains at the time you run the report.

• Chapter 6, Server: System Activity Reports. System Activity reports monitor 
and track system-wide activity of the Pyxis Enterprise Server.

Conventions

Text
This document uses the following conventions:

• Document titles, cross-references, and text that requires emphasis are 
formatted in italics.

• The names of buttons, menu commands, options, and icons are formatted in 
bold.

• User input is formatted in Courier bold.

Notice Indicators

NOTE
Notes contain supplementary information or emphasize a point or procedure.
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Chapter 1
Introduction

This chapter describes how reports are listed in this document and what 
information is provided for each report. The chapter also identifies which reports 
are considered important to most facilities.

Critical reports .......................................................................................... 2

Exporting reports ...................................................................................... 3

Scheduling Reports.................................................................................... 7

Using Show/Hide feature........................................................................... 3

General report information ....................................................................... 4

Creating My Reports ................................................................................. 5

Scheduling Reports.................................................................................... 7
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Updates
• Delivery Confirmation with Pyxis ES Link report records the Queued, In 

Transit and Delivery times for Pyxis ES link.

• Fractional Unit of Measure values added to All Device Events report and All 
Discrepancies report.

• Zoom functionality for scheduled reports allows a print preview when 
scheduling a report. This indicates if all columns fit across the page.

• Report column headers lock so that column titles are fixed when scrolling 
down to view additional rows for rendered reports.

Rendered reports open in a separate browser window to allow users to view 
more of their reports.

Critical reports
This section lists the reports that CareFusion considers to be important to a 
hospital using Pyxis Enterprise Server or Pyxis MedStation ES, and also lists the 
reports frequently used by pharmacy and nursing staff.

Important reports
CareFusion considers the following reports to be important to any hospital.

• All Device Events report on page 14 

• All Discrepancies report on page 14 

• Hospital Wide Med Summary report on page 23

• Delivery Confirmation with Pyxis ES Link report on page 15

• Ordered Meds Not Loaded report on page 24

• Patient to Patient Transfer report on page 16

• Pick and Delivery report on page 25

• Returns and Wastes report on page 18

Frequently used reports 
The following reports are used frequently to manage the system.

• All Device Events report on page 14

• All Discrepancies report on page 14

• Clinical Data Category Response report on page 15

• Hospital Wide Med Summary report on page 23

• Delivery Confirmation with Pyxis ES Link report on page 15

• Ordered Meds Not Loaded report on page 24
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Exporting reports
 
• Patient to Patient Transfer report on page 16

• Returns and Wastes report on page 18

Exporting reports
Reports can be exported and saved to a local PC in Adobe® PDF version 9.0 or in 
the additional formats listed below.

To export reports to PDF, Word, or Excel
After you run a report, you can export a report from the Report Viewer screen.

1. Select the Export icon to open the dropdown list.
2. Select the format:

• XML file with report data
• CSV (comma delimited)
• Acrobat (PDF) file
• MHTML (web archive)
• Excel
• TIFF file
• Word
The file is exported.

3. Select Save, Save as, or Save and open.
4. Select Open folder to view the file that you exported.

Using Show/Hide feature
You can customize your reports. In the screen that appears after you select Run, 
select the data columns that you want to show in your report and deselect the data 
columns that you want to hide. You can save these choices to My Reports.
Pyxis ES System Reports Book 3
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General report information
The following information applies to all reports:

• The time and date of the local dispensing device is used for the report. Times 
are displayed in 24-hour clock format.

• Reports can be viewed in Internet Explorer® version 7 or version 8.

• Reports can be run on demand.

• Reports can be printed to a designated printer.

• Search filters allow you to control the information that appears in the report.

• If you do not select any filter criteria, the report displays all of the data for the 
selected Group mode.

• If you select medication data which is not available, no medication activity is 
displayed.

• If exporting to Word 2003, click View > Print Layout to see the header and 
footer of the exported report.

• If exporting to Word 2007 and 2010, the header and footer can be viewed 
directly in the document.

NOTE
The Microsoft update 956391 may prevent reports from being printed. If this 
happens, resolve the issue as follows:

• Before printing a report, add the server application site to your trusted sites 
by opening the Internet Explorer browser and going to Tools > Internet 
Options > Security > Trusted Sites > Sites. If the protocol is https, clear the 
check box for Require Server verification (https:) for all sites in the zone.

• Refresh the page or close the browser and open the page again.
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Creating My Reports
 
Creating My Reports
Use My Reports to generate a report previously saved with your parameters. A 
new date range is prompted each time. Set up the report under the Run Reports 
menu, save it to My Reports, and then use that report format whenever you want to 
run that report. You can also change or add parameters and save a new My 
Reports.

Setting up My Reports under Run Reports
1. Go to Reports > Run Reports.
2. If required, select your facility from the dropdown list.
3. Select your report by selecting the Group By available options.
4. Select the items to include in the report by selecting Include All or Allow 

Selection in each available tab.
5. If you select Allow Selection, select the items that you want included in the 

report.
• Selected Only becomes available after you select Allow Selection. Check 

the box, if needed.
6. If available, enter the start date and end date, or use the calendar button to 

enter the dates.
The date range can be up to 90 days.

7. Select Run.
The report is displayed in a separate browser window.

8. After the report is generated, select Add to My Reports.
9. Enter a report name and click OK.

Changing My Reports
1. Go to Reports > My Reports.

If you have permission to view all users reports, click Include all items to view.

2. On the My Reports screen, select Edit Filters in the Actions column.
Pyxis ES System Reports Book 5
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3. Select the tabs where you want to change the parameters. Depending on the 
type of report, these could include the following:
• Devices
• Meds (All)
• Med Classes (All)
• Users (All)
• Patients (All)

4. Select Save.
5. Run the report again.

Customizing My Reports
1. Go to Reports > My Reports.

If you have permission to view all user’s reports, click Include all items to 
view.

2. Select the report that you want to run.
3. In the Report Dates dialog box, select the start and end dates for the new 

report.
Click OK to go to the Report Viewer screen.

4. In the Report Columns section of the screen, select or deselect the information 
that you want to appear in your report.

5. Select Update Report.
6. In the Create My Report dialog box, you can rename the report or keep the 

report name.
See Updating reports in My Reports if keeping the report name.

Generating My Reports
1. Go to Reports > My Reports.
2. Select the report that you want to run.
3. In the Report Dates dialog box, select the start and end dates for the new 

report.
4. Click OK to go to the Report Viewer screen.

Deleting reports in My Reports
1. Go to Reports > My Reports.

If you have permission to view all user’s reports, click Include all items to 
view.

2. In the Actions column, select Delete for the report to be deleted.
3. In the dialog box that appears, select Yes.
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Updating reports in My Reports
1. To update a report format, generate the report again in Run Reports with the 

changed parameters you want in the new report.
2. Select Run.
3. Select Add to My Reports.
4. Enter the same report name as the report you are replacing.
5. Select Overwrite to replace the previous report.
6. Select Ok.

Scheduling Reports
You must have permission to access Scheduled Reports to configure scheduled 
reports. Make sure you have created reports in My Reports before you attempt to 
schedule reports. See Creating My Reports on page 5.

1. Select Reports > My Reports.
If you have permission to view all user’s reports, click Include all items to 
view.

2. In the Actions section, select Schedule.
3. In the Create Schedule screen, enter the information you need for scheduling 

your report in the following sections:
• Frequency—daily, weekly, or monthly.
• Time to Run—you can run the report more than once each scheduled day.
• Range of Occurrence—click the calendar to select the start date and end 

date. If you do not want to select an end date, select the No End Date 
option.

• Printer Settings—from the dropdown lists, select the printer name, paper 
size, and paper orientation that you want for your report.

4. Click OK.

5. Repeat the previous steps of this procedure for each scheduled report to be 
created.

6. In the Schedule List screen, click Add Schedule to complete the process.

To edit or delete a scheduled report
 Go to Reports > Manage Schedules and select the Edit or Delete button under 

the Actions section.
If you have permission to view all user’s reports, click Include all items to 
view.

NOTE
Administrators with Manager Server Reports permission can see each other’s 
scheduled reports and can modify them.
Pyxis ES System Reports Book 7
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Chapter 2
Device reports

Device reports are reports generated on the device. These reports are designed to 
help your workflow, and they are specific to the mission-critical needs of your 
hospital as you manage medication dispensing and inventory. 

The appropriate use of this report function is determined by your hospital’s 
policies and procedures.

Currently, the following reports can be generated at the device:

• Inventory

• Refill Pick

• Refill Delivery

• Events

Generating reports .................................................................................. 10

Inventory reports ..................................................................................... 10

Refill Pick reports.................................................................................... 11

Refill Delivery reports ............................................................................. 11

Device Events reports.............................................................................. 12
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Generating reports
1. On the main menu screen, touch Reports.
2. In the Reports menu, touch the button that corresponds to the type of report 

that you want to generate.
3. Each report can be sorted by groups and tabs. 

• Touch the Grouped by: buttons to select how you want the information 
grouped.
Touch the tabs to select the information you want included in the report. 
For example, select Drawer or Med Class.

• To include all information for a particular category of data, select All.
• Touch the specific data you want to include in the report or select All.
For example, if you are generating an Inventory report, generating a drawer-
specific inventory report, touch the drawer tab and then select the drawer to 
create a report that includes only data from that drawer.

4. Touch Run Report. 
After running a report, use the scroll bar or swipe your finger up or down the 
screen to review the report.

Inventory reports

Group By Tabs Report Information (alphabetical order)

This report produces a complete inventory by device, by drawer, or by outdated 
medications, and includes only those items that are below minimum or below 
maximum counts.

•  Station
•  Med
•  Station 

Outdated Meds

•  Meds
•  Med Class
•  Drawer

•  Current
•  Device
•  Drw/Pkt
•  Filter
•  Maximum

•  Medication
•  Medication amount
•  Minimum
•  Report Date/Time
10 Pyxis ES System Reports Book



Refill Pick reports
 
Refill Pick reports

Group By Tabs Report Information (alphabetical order)

This report is for selecting medications to refill.

Refill Delivery reports

Group By Tabs Report Information (alphabetical order)

This report is for medication delivery. 

•  At or below 
minimum

•  All below 
maximum

•  Meds
•  Med Class
•  Drawer
•  Pick Area

•  Area
•  Checked By
•  Date
•  Device
•  Drw/Pkt
•  Facility
•  Filter

•  Medication
•  Medication amount
•  Pick Amount
•  Pick/Actual
•  Pick Area
•  Picked By
•  Report Date/Time

•  At or below 
minimum

•  All below 
maximum

•  Meds
•  Med Class
•  Drawer
•  Pick Area

•  Area
•  Checked By
•  Current
•  Date
•  Delivered By
•  Facility
•  Filter

•  Medication
•  Medication amount
•  Minimum/Maximum
•  Refill
•  Report Date/Time
•  Zone Drw/Pkt
Pyxis ES System Reports Book 11
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Device Events reports

Group By Tabs Report Information (alphabetical order)

The All Device Events report allows you to view all medication transactions at the 
device for the reporting period. This report can also be used to research 
discrepancies.

•  Device
•  Med
•  User
•  Patient

•  Patients
•  Meds
•  Med class
•  Users

•  Area
•  Beg (quantity)
•  Brand Name
•  Date of Birth
•  Device
•  Drawer | Sub Drawer | 

Pocket
•  End (quantity)
•  Fractional (Y/N)
•  Med class
•  Med Description
•  Med ID
•  Order #
•  Order end date and time
•  Order start date and time

•  Override reason
•  Patient ID
•  Patient name
•  Quantity
•  Report Date/Time
•  Start Date/End Date
•  Transaction date/time
•  Transaction Type
•  Undocumented waste
•  UOM (Unit of Measure)
•  User ID
•  User name
•  User type
•  Witness ID
•  Witness name
12 Pyxis ES System Reports Book



 

Chapter 3
Server: Activity reports

Activity reports detail all user interactions with the system (a transaction history) 
for specific stations. Activity reports include specific information on all accesses, 
charges and credits, loading and unloading, discrepancies in the system, and refill 
activities. Use these reports to get an overall view of how your device is 
functioning and how to improve its usage.

All Device Events report.......................................................................... 14

All Discrepancies report.......................................................................... 14

Clinical Data Category Response report ................................................ 15

Delivery Confirmation with Pyxis ES Link report................................... 15

Patient to Patient Transfer report ........................................................... 16

Profile Override report............................................................................ 17

Remove Warnings report ......................................................................... 17

Return Bin Activity report ....................................................................... 18

Returns and Wastes report....................................................................... 18

User to User Transfer.............................................................................. 19
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All Device Events report

Group By Report Parameters Report Information (alphabetical order)

Provides information regarding device events.

All Discrepancies report

Group By Report Parameters Report Information (alphabetical order)

Identifies discrepancies throughout a hospital for a given time period.

•  Device
•  Medication
•  Patient
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Patient Reconciliation Status
•  Patients (All)
•  Patient Types (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Transaction Types (All)
•  Users (All)

•  Area
•  Beginning
•  Beg/End UOM
•  Brand Name
•  Date of Birth
•  Device
•  Drw|Sub Drw|Pkt
•  End
•  Facility
•  Fractional
•  Med Class
•  Med Description
•  Med ID
•  Order #
•  Order End Date and Time
•  Order Start Date and Time
•  Patient ID

•  Patient Name
•  Reason
•  Report Date/Time
•  Quantity
•  Qty UOM
•  Session Begin
•  Session End
•  Session Type
•  Transaction Date/Time
•  Transaction Element
•  Transaction Type
•  Undocumented Waste
•  User ID
•  User Name
•  User Type
•  Witness Name
•  Witness ID

•  Device •  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Resolution Status
•  Selected Only
•  Transactions Before/After
•  Users (All)

•  Alternate ID
•  Auto-Resolved
•  Begin
•  Beg/End UOM
•  Brand Name
•  Device
•  Discrepancy Quantity
•  Discrepancy Resolution 

Description
•  Drw|Sub Drw|Pkt
•  End
•  Facility
•  Fractional
•  Med Class
•  Med Description

•  Med ID
•  Patient ID
•  Patient Name
•  Patient Type
•  Quantity
•  Quantity UOM
•  Reason
•  Report Date/Time
•  Resolution Date/Time
•  Resolved By
•  Transaction Date/Time
•  Transaction Type
•  User Name/ID
•  Witness 
•  Zone
14 Pyxis ES System Reports Book



Clinical Data Category Response report
 
Clinical Data Category Response report

Group By Report Parameters Report Information (alphabetical order)

Lists clinical data category (CDC) responses.

Delivery Confirmation with Pyxis ES Link 
report

Group By Report Parameters Report Information (alphabetical order)

This report records the Queued, In Transit, and Delivery times for Pyxis ES Link 
deliveries as well as who performed each step. It also displays the time the 
delivery took from Queued to Delivered. The report contains data only if Pyxis ES 
Link is installed on your system.

•  Device
•  Patient

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Patients (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Alternate ID
•  Brand Name
•  CDC Notice
•  CDC Response
•  Device
•  Facility
•  Instruction Text
•  Med Class
•  Med Description

•  Med ID
•  Order #
•  Patient Name/ID
•  Quantity
•  Report Date/Time
•  Room/Bed
•  Transaction Date/Time
•  Transaction Type
•  User Name/ID
•  User Response

•  Delivery 
Location

•  Delivery User

•  Allow Selection
•  Define Filter
•  Delivery Locations  (All)
•  Delivery Status
•  Include All
•  Patients (All)
•  Selected Only

•  Delivery Date/Time
•  Delivery Location
•  Delivery User ID
•  Delivery User Name
•  Elapsed Time
•  Facility
•  In Transit Date/Time
•  In Transit User ID

•  In Transit User Name
•  Order Description
•  Order Number
•  Patient ID
•  Patient Name
•  Queued Date/Time
•  Queued User ID
•  Queued User Name
Pyxis ES System Reports Book 15
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Med Refill Activity report

Group By Report Parameters Report Information (alphabetical order)

Lists all medication refill activities.

Patient to Patient Transfer report

This report displays patient transfer transactions which allow the user, such as an 
anesthesiologist, to transfer items from one patient to another where the initial 
patient no longer needs the items. Therefore, these items can be used by another 
patient requiring similar items.

•  Device
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Alternate ID
•  Begin
•  Brand Name
•  Device
•  Drw|Sub Drw|Pkt
•  End
•  Facility
•  Med Description

•  Med ID
•  Med Class
•  Report Date/Time
•  Quantity
•  Transaction Date/Time 
•  User ID
•  User Name
•  Zone

NOTE
This report is for Pyxis Anesthesia ES stations only.

Group By Report Parameters Report Information (alphabetical order)

•  Originating 
Patient

•  Receiving 
Patient

•  User

•  Allow Selection
•  Controlled Meds Only
•  Define Filter
•  Include All
•  Med Classes (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Amount Transferred
•  Brand Name
•  Controlled
•  Device
•  Facility
•  Med Class
•  Med Description
•  Med ID

•  Originating Patient
•  Originating Patient ID
•  Quantity Transferred
•  Receiving Patient
•  Receiving Patient ID
•  Report Date/Time
•  Transfer Date/Time
•  User
16 Pyxis ES System Reports Book



Profile Override report
 
Profile Override report

Group By Report Parameters Report Information (alphabetical order)

Lists all Profile Override transactions that occurred during the specified time 
frame. A profile override is used when removing medications for a temporary 
patient.

Remove Warnings report

Group By Report Parameters Report Information (alphabetical order)

Lists all remove warnings that were overridden and the response that was entered 
to support the override.

•  Device
•  Medication
•  Patient
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Patients (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Alternate ID
•  Area 
•  Begin
•  Brand Name
•  Device
•  Drw|Sub Drw|Pkt
•  End
•  Facility
•  ID
•  Med Class
•  Med Description

•  Med ID
•  Override Reason
•  Patient Name
•  Quantity
•  Report Date/Time
•  Room/Bed
•  Transaction Date/Time
•  Transaction Type
•  User ID
•  User Name
•  User Type

•  Location
•  Patient

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Patients (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Alternate ID
•  Area
•  Brand Name
•  Device
•  Facility
•  Med Description
•  Med Class
•  Med ID
•  Patient Name/ID

•  Quantity
•  Report Date/Time
•  Too Close Reason
•  Transaction Type
•  Transaction/Cancelled
•  Transaction Date/Time
•  User Name/ID
•  Warning Type
Pyxis ES System Reports Book 17
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Return Bin Activity report

Group By Report Parameters Report Information (alphabetical order)

This report lists all transactions— which includes users and medications—for the 
return bin.

Returns and Wastes report

Group By Report Parameters Report Information (alphabetical order)

Links a transaction with its previous Remove transaction. Shows who returned 
medications to a specified location and who wasted a medication. Use this to track 
narcotics and potential diversion.

•  Device
•  Medication
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Meds (All)
•  Med Classes (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Bin Type
•  Facility
•  Device
•  Med Description
•  Med Class
•  Med ID

•  Quantity
•  Report Date/Time
•  Transaction Date/Time 
•  Transaction Type
•  User ID
•  User Name

•  Device
•  Patient

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Meds (All)
•  Med Classes (All)
•  Patients (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Activity
•  Alternate ID
•  Area
•  Begin
•  Brand Name
•  Device
•  End
•  Facility
•  Drw|Sub Drw|Pkt
•  Med Class

•  Med Description
•  Med ID
•  Patient Name/ID
•  Quantity/Amount
•  Report Date/Time
•  Room/Bed
•  Transaction Date/Time
•  User ID
•  User Name
18 Pyxis ES System Reports Book



User to User Transfer
 
User to User Transfer

Group By Report Parameters Report Information (alphabetical order)

This report lists medications that have been removed from one user’s My Items 
list and transferred to another user’s My Items list.

NOTE
This report is for Pyxis Anesthesia ES stations only

•  Originating 
User

•  Receiving 
User

•  Allow Selection
•  Define Filter
•  Include All
•  Originating Users (All)
•  Receiving Users (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only

•  Alt ID
•  Amount Transferred
•  Brand Name
•  Device
•  Facility
•  Med Class
•  Med Description

•  Med ID
•  Originating User/(User ID)
•  Quantity
•  Receiving User
•  Receiving User ID
•  Report Date/Time
•  Transfer Date/Time
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Chapter 4
Server: Inventory reports

Inventory reports provide a detailed account of the status of inventory throughout 
the system, allowing effective inventory management. You can generate these 
reports for specific devices or for all devices. Depending on the report selected, 
you can also generate reports by zone, area, item name, item ID, and door and bin.

All Orders report ..................................................................................... 22

Device Inventory report........................................................................... 22

Empty Pockets report .............................................................................. 22

Hospital Wide Med Summary report ....................................................... 23

Meds Ordered and Below Min report...................................................... 23

My Items Aging report............................................................................. 24

Ordered Meds Not Loaded report ........................................................... 24

Outdated Inventory report....................................................................... 25

Pick and Delivery report ......................................................................... 25

Pick and Delivery Summary report ......................................................... 26

Stock Out Summary report ...................................................................... 26
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All Orders report

Group By Report Parameters Report Information (alphabetical order)

Identifies all patients and their medications.

Device Inventory report

Group By Report Parameters Report Information (alphabetical order)

Provides a list of all inventory at one or more devices.

Empty Pockets report

Group By Report Parameters Report Information (alphabetical order)

Zone

Provides a list of all empty pockets within a zone.

•  Medication
•  Patient
•  Unit

•  Allow Selection
•  Define Filter
•  Include All
•  Meds
•  Patients
•  Selected Only
•  Units

•  Administrative Notes
•  Admit Time
•  Alternate ID
•  Backordered
•  Brand Name
•  Condition Text
•  Dispensing Notes
•  Dose
•  Facility
•  Frequency
•  Maximum Dose
•  Med Class
•  Med Description
•  Med ID

•  Order #
•  Order Start Time
•  Order Stop Time
•  Ordering Physician
•  Patient ID
•  Patient Name
•  Report Date/Time
•  Room/Bed
•  Route
•  Service Duration
•  Timing Record Priority
•  Timing Record Start/Stop
•  Total Occurrence
•  Unit

•  Device
•  Medication
•  Outdated Med

•  Allow Selection
•  Define Filter
•  Drawers 
•  Devices 
•  Include All
•  Meds 
•  Med Classes 
•  Selected Only

•  Backordered
•  Brand Name
•  Current Quantity
•  Device
•  Drw|Sub Drw|Pkt
•  Facility
•  Facility Alternate ID
•  Loaded as Fractional
•  Maximum

•  Med Class
•  Med Description
•  Med ID
•  Minimum
•  Outdate Tracking
•  PIS Alternate ID
•  Report Date/Time
•  Zone

•  Allow Selection
•  Define Filter
•  Devices 
•  Drawers 
•  Include All
•  Selected Only

•  Device
•  Drawer
•  Drawer Type
•  Empty Pockets

•  Facility
•  Report Date/Time
•  Zone
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Hospital Wide Med Summary report
 
Hospital Wide Med Summary report

Group By Report Parameters Report Information (alphabetical order)

Device
Medication

Identifies pockets containing specific medications.

Meds Ordered and Below Min report

Group By Report Parameters Report Information (alphabetical order)

Device

Provides a summary of medications ordered with inventory at or below the 
minimum set for the medication, which helps you identify ordered medications 
that are due for a refill.

•  Allow Selection
•  Define Filter
•  Devices 
•  Include All
•  Meds 
•  Med Classes 
•  Selected Only

•  Alternate ID
•  Area
•  Back Ordered
•  Brand Name
•  Current Quantity
•  Device
•  Facility
•  Med Class

•  Med Description
•  Med ID
•  Maximum
•  Minimum
•  Pick Area
•  Report Date/Time
•  Total

•  Allow Selection
•  Define Filter
•  Devices 
•  Exclude Backordered Items
•  Include All
•  Meds 
•  Med Classes
•  Selected Only

•  Actual
•  Alternate ID
•  Area
•  Brand Name
•  Current Quantity
•  Device
•  Facility

•  Maximum
•  Med Class
•  Med Description
•  Med ID
•  Minimum
•  Refill Amount
•  Report Date/Time
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My Items Aging report

Group By Report Parameters Report Information (alphabetical order)

User

This report shows a list of aging or outstanding items dispensed in My Items that 
were yet to be reconciled at the time of the report generation.

Ordered Meds Not Loaded report

Group By Report Parameters Report Information (alphabetical order)

Location

Consists of two reports: one that includes equivalencies and one that does not. 
Provides a summary of ordered medications (sorted by area) that are not loaded 
and might need to be loaded immediately.

NOTE
This report is for Pyxis Anesthesia ES stations only.

•  Allow Selection
•  Devices (All)
•  Include All
•  Items Older Than
•  Med Classes (All)
•  Meds (All)
•  Name
•  Selected Only
•  Users (All)

•  Brand Name
•  Device
•  Facility
•  Med Class
•  Med Description
•  Med ID

•  My Items Date/Time
•  Remaining Amount
•  Remaining Quantity
•  Removed Amount
•  Removed Quantity
•  Report Date/Time

•  Allow Selection
•  Areas (All)
•  Define Filter
•  Include All
•  Med Classes (All)
•  Meds (All) 
•  Selected Only

•  Administrative Notes
•  Alternate ID
•  Area
•  Backordered
•  Brand Name
•  Condition Text
•  Device
•  Dispensing Notes
•  Dose
•  Facility
•  Frequency
•  Loaded Device
•  Maximum Dose
•  Med Class

•  Med Description
•  Med ID
•  Order #
•  Order Start Time
•  Order Stop Time
•  Patient Name/ID
•  Quantity
•  Report Date/Time
•  Room/Bed
•  Route
•  Service Duration
•  Timing Record Priority
•  Timing Record Start/Stop
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Outdated Inventory report
 
Outdated Inventory report
Identifies medications that have expired or will expire in the specified time 
period.

Pick and Delivery report

Group By Report Parameters Report Information (alphabetical order)

Consists of two reports: one for picking medications to refill and one for delivery 
of the medications.

Group By Report Parameters Report Information (alphabetical order)

•  Device
•  Zone

•  Define Filter
•  Devices (All)
•  Expiration period (dropdown 

list: Now, 7 Days, 30 Days, 
60 Days, and 90 Days)

•  Include All
•  Med Classes (All)
•  Meds (All)
•  Selected Only

•  Brand Name
•  Device
•  Drw|Sub Drw|Pkt
•  Expiration Date
•  Expires In (Days) - zero if 

expired

•  Facility
•  Med Description
•  Med ID
•  Med Class
•  Report Date/Time
•  Zone

•  Device
•  Medication
•  Zone

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Exclude Backordered 

Items—check box
•  Include All
•  Inventory Filter Type 

(dropdown list)
•  Med Classes (All)
•  Meds (All)
•  Pended Meds Filter 

(dropdown list)
•  Pick Areas (All)
•  Selected Only
•  Zone (All)

•  Brand Name
•  Current Amount
•  Delivery Area
•  Device
•  Drw|Sub Drw|Pkt
•  Facility
•  Maximum
•  Med Description
•  Med ID

•  Minimum
•  Pended (indicated by *)
•  Pick Actual
•  Pick Amount
•  Pick Area
•  Refill Actual
•  Refill Amount
•  Report Date/Time
•  Zone
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Pick and Delivery Summary report

Group By Report Parameters Report Information (alphabetical order)

This report is for picking medications to refill and lists the total quantity of each 
medication that needs to be filled for the entire facility. Provides a report for the 
delivery of medications for a device. The delivery report identifies how much 
must be delivered and where.

Stock Out Summary report

Group By Report Parameters Report Information (alphabetical order)

Identifies medications whose quantities have reached zero.

•  Device
•  Medication
•  Zone

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Exclude Backordered Items
•  Include All
•  Inventory Filter Type (drop-

down list)
•  Med Classes (All)
•  Meds (All)
•  Pended Meds Filter
•  Pick Areas (All)
•  Selected Only
•  Zone (All)

•  Brand Name
•  Current Amount
•  Delivery Area
•  Device
•  Facility
•  Maximum
•  Med Description
•  Med ID
•  Minimum

•  Pended indicated by *
•  Pick Actual
•  Pick Amount
•  Pick Area
•  Refill Actual
•  Refill Amount
•  Report Date/Time
•  Zone

•  Device
•  Medication
•  Zone

•  Allow Selection
•  Areas (All)
•  Define Filter
•  Devices (All)
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only

•  Alternate ID
•  Area
•  Brand Name
•  Device
•  Drw|Sub Drw|Pkt
•  Duration
•  Facility
•  Maximum

•  Med Class
•  Med Description
•  Med ID
•  Minimum
•  Quantity
•  Report Date/Time
•  Stock Out End
•  Stock Out Start
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Chapter 5
Server: System reports

System reports provide you with a snapshot of what the system contains at the 
time you run the report. For example, you can run a Formulary report, which lists 
all formulary items in the system and their options, or you can run a Clinical Data 
Categories report, which lists all clinical data categories currently defined and any 
associated lists.

Devices report ......................................................................................... 28

Formulary report..................................................................................... 29

Patients report ......................................................................................... 29
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Devices report

Group By Report Parameters Report Information (alphabetical order)

Lists all the devices in the system and configuration options.

•  Area
•  Device
•  Unit

•  Allow Selection
•  Areas (All)
•  Devices (All)
•  Include All
•  Define Filter
•  Selected Only
•  Units (All)

•  Area
•  Blind Count
•  Computer Name
•  Device
•  Discharge Delay - HH:MM
•  Facility
•  Login Mode
•  Menu Timeout - MM:SS
•  Witness Required for 

Dispensing
•  Open Drawer Timeout - 

MM:SS
•  Outdate Tracking

•  Patient Keep Time - HH:MM
•  Report Date/Time
•  Return to Stock
•  Status
•  Too Close Warning
•  Type
•  Units
•  Witness Required for 

Dispensing
•  Witness Required to Empty 

Return Bin
•  Zone
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Formulary report
 
Formulary report

Group By Report Parameters Report Information (alphabetical order)

Lists all formulary items in the system and their configuration options at the time 
the report is generated.

Patients report
Lists and describes all patients in the system.

•  Medication •  Allow Selection
•  Define Filter
•  Include All
•  Med Classes (All)
•  Meds (All)
•  Override Groups (All)
•  Selected Only

•  Active
•  Anesthesia Reverification
•  Auto Resolve Discrepancies
•  Backordered
•  Block Load Devices
•  Brand Name
•  CDC On Override
•  CDC On Remove
•  CDC On Return
•  CDC on Waste
•  Chargeable
•  Concentration Volume/Unit
•  Controlled
•  Critical Low %
•  Custom Fields 1–3
•  Dispensing Notes
•  Display Name
•  Dosage Form
•  Facility
•  Facility Alternate ID
•  Generic Name
•  Has Equivalencies
•  Has Variable Dose Settings
•  Hazardous Waste Class
•  High Cost
•  High Risk
•  Inventory Notes
•  Is In System Kits
•  Issue Unit of Measure
•  Med Class
•  Med ID
•  Multi-Dose

•  Non Med
•  Ordered Med Not Loaded
•  Outdate Tracking
•  Override Group
•  Pick Area
•  PIS Alternate ID
•  Pure Generic Name
•  Refill Unit of Measure
•  Replenishment Pick Area
•  Replenishment Scan Option
•  Report Date/Time
•  Return Option
•  Scan on Load/Refill
•  Security Group
•  Split Allowed
•  Stock Out Bulletin
•  Strength/Unit
•  Therapeutic Class
•  Too Close to Remove
•  Total Volume/Unit
•  Track Quantity
•  Verify Count Mode
•  Witness on Empty Return Bin
•  Witness on Inventory
•  Witness on Load/Refill
•  Witness on Outdate
•  Witness on Override
•  Witness on Remove
•  Witness on Return
•  Witness on Waste
•  Witness on Unload

Group By Report Parameters Report Information (alphabetical order)

•  Patient •  Allow Selection
•  Define Filter
•  Include All
•  Patients (All)
•  Units (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only

•  Admission Status
•  Admit Time
•  Created at Device
•  Discharge Time
•  Encounter ID
•  Facility

•  Patient ID
•  Patient Name
•  Report Date/Time
•  Room/Bed
•  Unit
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Chapter 6
Server: System Activity 

Reports

System Activity reports monitor and track system-wide activity of the Pyxis 
Enterprise server. You can determine what user information has been modified 
and by whom, and track system access. These reports help you maintain both the 
security and consistency of the Pyxis Enterprise server in your hospital.

BioID Global report ................................................................................ 32

Device Activity Log ................................................................................. 32

Entered Temp Patient Information report ............................................... 32

Patient Visit Reconciliation report .......................................................... 33

Server Activity Log .................................................................................. 33

SMART Remote Manager Temperature Log ........................................... 34

User Scanning Compliance report .......................................................... 34
Pyxis ES System Reports Book 31



Chapter 6—Server: System Activity Reports

 

BioID Global report

Group By Report Parameters Report Information (alphabetical order)

Tracks BioID logon activity and statistics by device or user.

Device Activity Log

Group By Report Parameters Report Information (alphabetical order)

Lists all device activities.

Entered Temp Patient Information report

Group By Report Parameters Report Information (alphabetical order)

Tracks admission, discharge, and transfer (TEMP PATIENT) information entered 
through any device. This includes all patients whose information was entered 
manually. CareFusion recommends that you run the report to monitor the number 
of patients that are being added at each device. Make sure that only authorized 
personnel are adding patients and that the patients exist.

•  Device
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Users (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only

•  # of Unique Users
•  # of Unique Unsuccessful 

Users
•  % of Successful Sign In 

Attempts
•  % of Unique Unsuccessful 

Users
•  % of Unsuccessful Sign In 

Attempt

•  Device
•  Facility
•  Report Date/Time
•  Sign In Attempts
•  Successful Sign In Attempts
•  Unsuccessful Sign In 

Attempts

•  Device
•  User

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Users (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only

•  Action
•  Activity Type
•  Affected Element
•  Area
•  Device

•  Facility
•  Report Date/Time
•  Transaction Date/Time
•  User ID 
•  User Name

•  Creator
•  Device
•  Patient

•  Allow Selection
•  Define Filter
•  Devices (All)
•  Include All
•  Patients (All)
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Comments
•  Creator Name/ID
•  Date of Birth
•  Device
•  Facility

•  Gender
•  Patient Name/ID
•  Record Creation Date
•  Report Date/Time
•  Unit
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Patient Visit Reconciliation report
 
Patient Visit Reconciliation report
This report is for auditing patients who are manually created and ensure that they 
are reconciled against an ADT patient if the facility has it.

When running a Patient Visit Reconciliation Report, the following options are 
available:

• Visit Record Age—This is a drop down list and the options are 24 Hours 
(default), 48 Hours, 72 Hours, 30 Days, and All.

• Visit Record Source—This is a dropdown list and the options are All 
(default), Temporary, System.

• Patient Reconciliation Status—This is a dropdown list and the options are All 
(default), Reconciled, Unreconciled.

Group By Report Parameters Report Information (alphabetical order)

Server Activity Log

Group By Report Parameters Report Information (alphabetical order)

Lists all server activities.

•  Patient •  Allow Selection
•  Define Filter
•  Include All
•  Patient Reconciliation Status
•  Selected Only
•  Units (All)
•  Users (All)
•  Visit Record Age
•  Visit Record Source

•  Created at Device
•  Created By
•  Date/Time Created
•  Date/Time Reconciled
•  Facility
•  Merged with Patient
•  Merged with Primary Patient 

ID
•  Number of Controlled 

Substance Removals
•  Reconciled By
•  Report Date/Time

•  Temporary Patient
•  Temporary Patient Date of 

Birth
•  Temporary Patient ID
•  Temporary Patient Unit
•  Time to Reconcile 

(DAYS:HOURS)
•  Total Number of Med 

Removals
•  Type of Record
•  Unreconciled Age 

(Days:Hours)

•  Activity Type
•  User

•  Activity Types (All)
•  Allow Selection
•  Define Filter
•  Include All
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  Users (All)

•  Action
•  Activity Date and Time
•  Activity Type
•  Affected Element

•  Facility
•  Report Date/Time
•  User ID 
•  User Name
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SMART Remote Manager Temperature 
Log

Group By Report Parameters Report Information (alphabetical order)

This log lists the temperature readings, reading status (in or out of range), and the 
temperature out-of-range resolution status for all Pyxis SMART Remote 
Managers in the hospital.

User Scanning Compliance report

Group By Report Parameters Report Information (alphabetical order)

This report lists the scan rates for loaded medications that are configured for scan 
on load, refill, removes and returns.

•  Device •  Allow Selection
•  Define Filter
•  Include All
•  Reading status
•  Report Start Date—enter date
•  Report End Date—enter date
•  Selected Only
•  SMART Remote Managers 

(All)

•  Facility
•  Reading Status
•  Reading Time
•  Report Date/Time
•  Resolution Date/Time
•  Resolution Desc

•  Resolved by
•  SMART Remote Manager 

Name
•  Temp Range
•  Temp Reading

•  User •  Report Start Date—enter date
•  Report End Date—enter date

•  Alt ID
•  Device
•  Facility
•  Med Class
•  Med Description
•  Med ID
•  Number of Overrides
•  Number of Successful Scans

•  Percent Compliant
•  Percent Non-Compliant
•  Report Date/Time
•  Total # of Items Requiring 

Scan
•  Transaction Type
•  User Name
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